Release Notes:
Thermo-Calc Software Package
Version 2018a

© 2018 Foundation of Computational Thermodynamics: Solna, Sweden
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thermo-Calc 2018a</td>
<td>2</td>
</tr>
<tr>
<td>Highlights</td>
<td>2</td>
</tr>
<tr>
<td><strong>Software Development Kits (SDKs)</strong></td>
<td>2</td>
</tr>
<tr>
<td>New Product: TC-Python API</td>
<td>2</td>
</tr>
<tr>
<td>TC-Python Examples</td>
<td>3</td>
</tr>
<tr>
<td>TC-Toolbox for MATLAB®</td>
<td>3</td>
</tr>
<tr>
<td><strong>Diffusion Module (DICTRA)</strong></td>
<td>4</td>
</tr>
<tr>
<td>Automatic Grid Point Placement</td>
<td>4</td>
</tr>
<tr>
<td>Pause, Plot and Tabulate Results and then Continue a Simulation</td>
<td>4</td>
</tr>
<tr>
<td>Improvements and Bug Fixes</td>
<td>5</td>
</tr>
<tr>
<td>Graphical Mode Only</td>
<td>5</td>
</tr>
<tr>
<td>Console Mode Only</td>
<td>5</td>
</tr>
<tr>
<td><strong>Precipitation Module (TC-PRISMA)</strong></td>
<td>5</td>
</tr>
<tr>
<td>Preexisting Particle Size Distribution</td>
<td>5</td>
</tr>
<tr>
<td>Interfacial Energy</td>
<td>7</td>
</tr>
<tr>
<td>Improvements and Bug Fixes</td>
<td>7</td>
</tr>
<tr>
<td><strong>Thermo-Calc</strong></td>
<td>7</td>
</tr>
<tr>
<td>Improvements and Bug Fixes</td>
<td>7</td>
</tr>
<tr>
<td>Both Graphical and Console Mode</td>
<td>7</td>
</tr>
<tr>
<td>Graphical Mode Only</td>
<td>8</td>
</tr>
<tr>
<td>Console Mode Only</td>
<td>8</td>
</tr>
<tr>
<td><strong>Databases</strong></td>
<td>9</td>
</tr>
<tr>
<td>New High Entropy Alloy Mobility Database (MOBHEA1)</td>
<td>9</td>
</tr>
<tr>
<td>New Version: High Entropy Alloy Thermodynamic Database (TCHEA3)</td>
<td>9</td>
</tr>
<tr>
<td>New Version: Aluminum Mobility Database (MOBAL4)</td>
<td>10</td>
</tr>
<tr>
<td><strong>Documentation</strong></td>
<td>10</td>
</tr>
<tr>
<td><strong>Installation</strong></td>
<td>10</td>
</tr>
<tr>
<td>Installation Disk Space Requirement</td>
<td>10</td>
</tr>
<tr>
<td><strong>Platform Roadmap</strong></td>
<td>1</td>
</tr>
</tbody>
</table>
Thermo-Calc 2018a

Highlights

★ **Thermo-Calc and SDKs:** New Product: TC-Python API and several Improvements and Bug Fixes.
★ **Diffusion Module (DICTRA):** Automatic Grid Point Placement and Pause, Plot and Tabulate Results and then Continue a Simulation.
★ **Precipitation Module (TC-PRISMA):** Preexisting Particle Size Distribution and Interfacial Energy.
★ **Databases:** New High Entropy Alloy Mobility Database (MOBHEA1) and new versions of TCHEA and MOBAL.

Software Development Kits (SDKs)

New Product: TC-Python API

For this, the first release of TC-Python, Thermo-Calc single equilibrium calculations and a wide-range of precipitation calculations, all that is available with the Precipitation Module (TC-PRISMA), can be integrated into your own programming workflow.

TC-Python is available with all operating systems supported by Thermo-Calc (Windows, Mac and Linux) and new examples are included with this API to help you learn about using the Python scripts as well as can be used as the basis for your own projects. See TC-Python Examples.

The way TC-Python is designed means every effort is made to guide you through the process of setting up the simulation, where good default values are used, for example. TC-Python is based on the Python™ programming language and supports Intellisense (intelligent code completion available in some IDEs) to help you more easily navigate through the available classes and methods. This minimises the occurrence of errors and makes it an easy option even for those who do not have experience working with APIs.

An example of the PyCharm IDE with an example of using the Intellisense (intelligent code completion) and its associated documentation that describes the classes and methods.
Some key features of TC-Python include:

- Python™ is a widely used language in the science community. It is easy to start with this coding language whether you are experienced or just starting out as a programmer.

- This new API is an integral part of the ICME framework, where you can couple it in a very open way. For example, you can use numerical packages like NumPy and SciPy in combination with our calculations as well as more easily do parallel computations.

- As an object-oriented approach, this makes it easier to reuse information (classes/methods) and more quickly run your calculations when you need to change the compositions, for example.

Until the end of 2018 we are offering a free trial license of TC-Python to all users with a valid Maintenance & Support Subscription, but you must contact Thermo-Calc. Request a free trial license by filling in the form on the TC-Python page on our website http://www.thermocalc.com/products-services/software/software-development-kits/tc-python/.

TC-Python Examples

Several examples are included with the installation. You can use these to both learn about the use of TC-Python and as a way to build your own calculation simulations.

To use these examples does not require a Precipitation Module (TC-PRISMA) license as each uses only up to three components, which is available for all users with a Thermo-Calc license. However, to run more complex precipitation calculations, you do need a valid Precipitation Module license.

- Two Thermo-Calc examples are included, one about calculating a single point equilibrium of a ternary system and another to do a single equilibrium to determine the solidus and liquidus temperature.

- Five Precipitation examples are included, which use the precipitation calculation engine in Thermo-Calc. The examples include the simulation of the kinetics of precipitation of Al_3Sc from an FCC-A1 solution phase, the kinetics of precipitation of both stable and metastable carbides from the ferrite phase, and how to create TTT and CCT diagrams when simulating the precipitation of gamma-prime (γ ′) phase from gamma (γ) phase in a Ni-Al-Cr alloy.

In Thermo-Calc, press F1 to search the online Help for “TC-Python Examples”. The Help also explains how to install TC-Python and how to access the documentation about the API (including details about the classes and methods). The documentation is available in both HTML and PDF formats, which are included with your Thermo-Calc installation and available on the web.

TC-Toolbox for MATLAB®

- Fixed a bug related to a license error and when using the dic_command.

- The example ‘calc_para_eq’ now runs normally.
**Diffusion Module (DICTRA)**

**Automatic Grid Point Placement**

In the Console Mode a new feature for automatic grid point distribution is implemented. The use of the option AUTO (instead of LINEAR or GEOMETRIC) in the **ENTER_GRID** command, generates an appropriate grid at the start of the simulation. The grid points are automatically distributed based on the entered composition profiles and boundary conditions, in combination with the kinetics of the system.

```
DICT> ** ENTER A GRID INTO THE REGION
DICT> **
DICT> ** FOR SIMPLICITY, AN EQUIDISTANT GRID IS USED
DICT> **
DICT> enter_grid_coordinates
REGION NAME : /AUSTENITE/: austenite
WIDTH OF REGION /1/: 1e-4
TYPE /LINEAR/: AUTO
DICT>
DICT> **
DICT> ** ENTER THE active PHASE INTO THE REGION
DICT> **
DICT> enter_phase_in_region
```

**Pause, Plot and Tabulate Results and then Continue a Simulation**

In the Graphical Mode version of the Diffusion module, you can now pause, make adjustments and then continue with the simulation just like you can in Console Mode. This allows you to visualize the results at various times in the calculation as well as add time at the end of a calculation if you decide more time is needed.
Release notes
Thermo-Calc version 2018a

In Thermo-Calc, press F1 to search the online help for more details about the ability to “Pause, Resume and Cancel Diffusion Calculations”.

Improvements and Bug Fixes

Graphical Mode Only

- Fixed an error that occurred with respect to the default naming of a region on the Diffusion Calculator. Now the regions are numbered sequentially to prevent calculation errors that indicate the region already exists.

Console Mode Only

- An error is now issued if the last entered temperature function does not end at infinite time (denoted ‘*’). This is implemented to avoid errors in which temperature become undefined during a simulation as for all times there should be a well-defined temperature.

Precipitation Module (TC-PRISMA)

Examples demonstrating the new features:

You can open the examples in Thermo-Calc by going to Help > Examples Files > Precipitation Module (TC-PRISMA). These are available to all users with a Thermo-Calc license and do not require any additional license to run the example. Also note that as part of the TC-Python release, there are five precipitation examples included. See TC-Python Examples.

Preexisting Particle Size Distribution

On the Precipitation Calculator you can now set the initial particle size distribution (PSD) parameters in the Show details section. The size distribution can be entered as a pre-defined distribution by importing a file or by manually entering information into a table. File types supported for importing a file are .xls, .xlsx, .csv or .txt.
The example P_10 demonstrates the use of this new feature. It demonstrates the effect of initial particle size distribution of the precipitate phases on the overall precipitation kinetics. It uses two Precipitation Calculators to simulate and compare carbide precipitations from a ferritic BCC_A2 matrix in a Fe-0.1C-12Cr alloy. Three carbides, CEMENTITE, M23C6 and M7C3, are included in the calculations for competitive precipitations, and the precipitation kinetics are compared with or without initial particle size distribution.

The example illustrates the use of the preexisting particle size distribution setting. You can import data from a spreadsheet or text file (.xls, .xlsx, .csv or .txt formats are acceptable). The Preexisting Particle Size Distribution window (shown below) provides a graphical representation of the radius versus corresponding frequencies.
**Interfacial Energy**

You can now enter interfacial energy as a function of temperature and particle size. The example P_11 demonstrates the use of this new feature.

In some cases, interfacial energy may be a function of temperature or particle radius. This example uses four Precipitation Calculators at four temperature points in 30 K increments: 673 K, 703 K, 733 K, and 763 K. It is an isothermal calculation to examine the mean radius of an Al-0.12Sc system. It uses an FCC_A1 matrix phase and AL3SC precipitate phase with bulk nucleation sites and user-defined interfacial energy function. The user-defined interfacial energy function uses an error function to set a smooth transition of the interfacial energy from 0.065 J/m² to 0.085 J/m² for particle radii below and above 1e-8m and 5e-8m, respectively.

**Improvements and Bug Fixes**

- You can now select the radius and particle length in the Table Renderer when tabulating the size distribution with a Precipitation Calculator.
- Updated the simulation time for example P_08: Precipitation of Cu-Ti CU4TI1 with Assumptions of Sphere and Needle Morphologies so there are new plots.
- Improved the set up for example P_06: Precipitation Ni-Al-Cr Non-isothermal Gamma-Gamma_prime. Note that it takes some time to run this example.

**Thermo-Calc**

**Improvements and Bug Fixes**

Both Graphical and Console Mode

- Improved convergence for phases with charged species. This improvement makes it easier to do equilibrium step and map calculations for oxides.
- Fixed a bug in the SGTE Solution database (versions SSOL4, SSOL5 and SSOL6) where you could not select the FCC Au-Cu system.
- Fixed a bug related to symbols and .EXP files. Previously, some symbols used for plotting large values would not work correctly when output to the plot.
- Issue fixed in Scheil simulation where the system solidified completely during the simulation.
- Updated the About window to include links to third-party licenses for open source libraries.
- Fixed an issue related to mapping where double results would be plotted in error.
- The function to calculate interfacial energy between two phases has been improved so that it is no longer sensitive to which phase is set as matrix and precipitate. This effects the *interfacial energy* model in the Property Model Calculator, the TQ function \( \text{tqgse} \), and interfacial energy calculations made by in the Precipitation Module if the interfacial energy is set to "calculated".
• When you are prompted to choose a file (e.g. when importing or opening a file), the available and relevant file types are now displayed in the drop-down menu. Some examples are given below of what you would see in Graphical Mode.

• For all operating systems, there are new shortcut keys. You can view the shortcuts in the File menu from within Thermo-Calc.

Example keyboard shortcuts for Windows and Linux (left) and Mac (right).

Graphical Mode Only
• Fixed a bug when using the Wizard template where selecting a user database would open two dialog boxes in error.
• Fixed an issue when trying to deselect all phases on a System Definer after choosing a database.
• The plot variable *Driving force* for Thermo-Calc and the Precipitation Calculator has changed name to *Normalized driving force* in order to better reflect what it actually is. It is the driving force divided with R*T (gas constant times temperature), and that makes the value dimensionless (without unit). The values are the same, only the name has changed.
• Fixed a bug where the components were wrong after opening a project file.
• Fixed a small error where notes added to an activity were previously not saved with the project file.
• Fixed a bug related to custom plot labels where a chosen color for a label was not kept (it defaulted to black) after reopening the file.

Console Mode Only
• More support for additional file types when dragging and dropping into the Console prompt. Now you can drag and drop these file types into the Console window: macro files (*.TCM and *.DCM), database files (*.TDB), and workspace files (*.POLY3, *.GES5, *.PAR, and *.DIC). Note that .DCM and .DIC file extensions are applicable to the Diffusion Module (DICTRA).
Release notes
Thermo-Calc version 2018a

- **SET LOG_FILE** command is improved. The created log file can now be directly used as a macro file. It now has .TCM extension by default and no log file information lines that produce syntax error messages.
- Fixed a bug in the Scheil module where the program stopped working when you tried to create an experimental file reader (.EXP) file.
- When working in the Database module, you can now cancel the selection of a user database. Previously the program would hang after clicking *Cancel* on the window that opened.
- Fixed an issue with the z-axis and the title of the resulting plot when working with a liquidus projection in the Ternary module.

**Databases**

### New High Entropy Alloy Mobility Database (MOBHEA1)

The new *TCS High Entropy Alloy Mobility Database (MOBHEA1)* is a kinetic database containing atomic mobility data for high-entropy alloys (HEA) presented in a format suitable for simulation of diffusion controlled phenomena using the add-on Diffusion Module (DICTRA) and/or Precipitation Module (TC-PRISMA). It can also be used together with all Thermo-Calc programming interfaces. MOBHEA1 is compatible and primarily recommended for use in combination with the TCS High Entropy Alloys Database (TCHEA3) thermodynamic database.

The MOBHEA1 database is based on TCS Ni-alloys Mobility Database (MOBNI4), and all relevant binary and ternary descriptions from MOBNI4 have been adopted directly. A systematic validation has been conducted for this mobility database and it was found that a majority of experimental diffusion couple composition profiles could be satisfactorily simulated with the Diffusion Module (DICTRA) in Thermo-Calc by using MOBHEA1 and TCHEA3.

- 22 elements: Al, B, C, Co, Cr, Cu, Fe, Hf, Mn, Mo, N, Nb, Ni, Re, Ru, Si, Ta, Ti, V, W, Y, Zr
- 5 phases FCC_A1, FCC_L12, BCC_A2, BCC_B2 and LIQUID

### New Version: High Entropy Alloy Thermodynamic Database (TCHEA3)

The TCS High Entropy Alloys Database (TCHEA3) has six new elements (B, Ir, Rh, Sn, Y and Zn) added, bringing the total to 26:

- Al, B, C, Co, Cr, Cu, Fe, Hf, Ir, Mn, Mo, N, Nb, Ni, Re, Rh, Ru, Si, Sn, Ta, Ti, V, W, Y, Zn and Zr.

With the addition of these elements, there are now more than 100 new binary systems and >150 new phases added.

TCHEA3 is suitable for studies of various HEAs, such as 3D transition metal alloys, refractory HEAs, low-density structure materials and so on, with the base structure of FCC, BCC or HCP, meanwhile with or without various precipitates.

With the combination of our new-released mobility database TCS High Entropy Alloy Mobility Database (MOBHEA1), TCHEA3 can be used for kinetic simulations of phase transformations.
New Version: Aluminum Mobility Database (MOBAL4)

The main changes to the TCS Aluminium-alloys Mobility Database (MOBAL4) compared with MOBAL3 are that it:

- Contains a new element Er
- Has an improved description of liquid
- Has many updated and new binaries and now includes ternary and quaternary descriptions:
  - 3 phases
  - 37 binary systems
  - 20 ternary systems
  - 2 quaternary systems

Documentation

In addition to the new TC-Python Examples and its documentation, plus two new Precipitation Module (TC-PRISMA) examples, there are new links from the Help menu and a new keyboard shortcut (F1) to open the Online Help.

Installation

- Fixed an issue on Linux operating systems where a license error was displayed when trying to modify (i.e. customize) an installation. This was applicable to the software development kit (SDK) installations (TC-API and TQ-Interface).
- Fixed an issue with a custom installation where you could not change the installation directory from the default.

Installation Disk Space Requirement

Due to precompiled databases added to the Thermo-Calc installation, 2 GB of disk space is recommended for the 2018a installation.

Platform Roadmap

Windows 32-bit is no longer supported.

For information about platforms being phased out visit http://www.thermocalc.com/products-services/software/system-requirements/platformroadmap/.